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Warning and Caution 
 
DISCLAIMER OF WARRANTY 
 

Magnetek’s Electromotive Systems, hereafter referred to as Company, assumes no responsibility for 
improper programming of a drive that resulted from use of this software. This software should only be 
used by a trained technician who has read and understands the contents of this manual. Normal use 
of this software may result in the drive parameters becoming modified. Improper programming of a 
drive can lead to unexpected, undesirable, or unsafe operation or performance of the drive. This may 
result in damage to equipment or personal injury. Company shall not be liable for economic loss, 
property damage, or other consequential damages or physical injury sustained by the purchaser or by 
any third party as a result of the use of this software. Company neither assumes nor authorizes any 
other person to assume for Company any other liability in connection with the sale or use of this 
software. 

 

 
1. Read this user manual in its entirety before installing IMPULSE®•LINK 4.1 Basic or operating the 

IMPULSE®•G+/VG+ Series 4, IMPULSE®•G+/VG+ Series 3, IMPULSE®•G+/VG+ Series 2, 
IMPULSE®•G+ Mini, IMPULSE®•P3 Series 2, OmniPulse DDC Variable Frequency Drives (VFD), 
OmniPulse DSD DC Drive, and/or the MagnePulse™ Digital Magnet Control. 

2. DO NOT connect or disconnect wiring, or perform signal checks while the electrical power is turned 
ON. 

3. Improper programming of a drive through the use of this software can lead to unexpected, undesirable, 
or unsafe operation or performance of the drive. 

 
Failure to observe these and other precautions indicated in this manual will expose the user to high 
voltages, resulting in serious injury or death. Damage to equipment may also occur. 
 

 

 

 
 
NOTICE 
No patent liability is assumed with respect to the use of the information contained herein. Moreover, Magnetek 
is constantly improving its high quality product; therefore, the information contained in this manual is subject to 
change without notice. Every precaution has been taken in the preparation of this document. Nevertheless, 
Magnetek assumes no responsibility for errors or omissions. Neither is any liability assumed for damages 
resulting from the use of the information contained in this publication. 
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Chapter 1 -  Introduction 

Overview  
 
IMPULSE•LINK 4.1 Basic is a user friendly, Windows® based, interactive drive communication software. It is 
designed for communication from your PC to the following Magnetek’s drives: 
 

 IMPULSE®•G+/VG+ Series 4 
 IMPULSE®•G+/VG+ Series 3 
 IMPULSE®•G+/VG+ Series 2 
 IMPULSE®•G+ Mini 
 IMPULSE®•P3 Series 2 
 OmniPulse DDC 
 OmniPulse DSD 
 MagnePulse™ Digital Magnet Control (DMC) 

 
The IMPULSE•LINK 4.1 Basic Kit (Part# 157-10028) contains the following components: 
 

1. CD containing IMPULSE•LINK Basic Software. 
  
2. Cable for IMPULSE•G+/VG+ Series 2 Drives. 

 
3. Cable for IMPULSE•G+/VG+ Series 4, Series 3, and G+ Mini Drives. 

 
4. Cable for OMNIPULSE•DDC and DSD Drives. 

 
5. USB-to-Serial converter. 

 
 

System Requirements 
 
Supported Drives  
IMPULSE•LINK 4.1 Basic supports the following Magnetek drives: 
 

 IMPULSE®•G+/VG+ Series 4 
 IMPULSE®•G+/VG+ Series 3 
 IMPULSE®•G+/VG+ Series 2 
 IMPULSE®•G+ Mini 
 IMPULSE®•P3 Series 2 
 OmniPulse DDC 
 OmniPulse DSD 
 MagnePulse™ Digital Magnet Control (DMC) 

 
PC Requirements 

1. Pentium class or equivalent 500MHz processor or better 
2. 256 MB RAM or better 
3. Minimum of 100 MB free hard-disk space available 
4. Windows 98 SE, 2000, XP, Vista, Windows 7, or Windows 8 operating system. 
5. Available USB or RS232 port. 
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Chapter 2 -  Installation  

Software Installation  
 
The IMPULSE•LINK 4.1 Basic CD contains: the IMPULSE•LINK 4.1 Basic Software and the communication 
profiles for the IMPULSE Drives used in your specific application. 

 

 To run the IMPULSE•LINK 4.1 Basic Setup, put the IMPULSE•LINK 4.1 Basic CD into your CD drive. 
(Run setup.exe from the CD if it does not start automatically) 

 Select the default choices during installation.  
 

 
 
 

 
 

 
Software Updates 
Additional features and bug fixes may be available from time to time. These may be downloaded from the 
Magnetek Material Handling website at www.magnetekmh.com/downloads.htm. 
 
Software Removal 
To remove the IMPULSE•LINK 4.1 Basic Drive Interface Software, open the Control Panel’s Add/Remove 
Programs dialog box, double-click the IMPULSE•LINK 4.1 Basic entry and choose Remove All from the 
IMPULSE•LINK 4.1 Basic Setup dialog box. 
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Creating Communication Profiles using the Wizard 
 
If you need to create a communication profile, there is 
a wizard to assist you.  In the Settings Menu, click 
“Communication”, and then Right-click on the folder 
“Communications Profile” and choose “Add Crane 
Profile”.  
 

 
 

 
 
Highlight the IMPULSE DRIVE, RS232 for the standard 
Serial connection, and then click “Select”.  The wizard 
will then take you through the following three steps to 
set up a new communication profile. 
 
 Step 1:  Name, Description, Crane and Motion 
 Step 2:  Common Port, Protocol, Slave Address, 

  Baud Rate, Parity 
 Step 3:  Finish 
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Chapter 3 -  Navigation 
The IMPULSE•LINK 4.1 Basic Software is a Windows-based software with easy to use menus and drop-down 
functions.  The user is able to access utilities for uploading/downloading parameters, comparing parameters, 
saving parameters to a file and more from the easy to navigate toolbar.  The main screen allows the user to 
access more commonly used features at click from the main screen. 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

New – Displays the controller 
properties dialog to create a new 
factory default parameter set, based on 
the drive type, software number, 
model, and kVA. 
 
Open – Opens or finds a file containing 
a parameter set for a specific drive 
type and software number. 
 
Save –  Saves the active file with its 
current file name and location. 
 
Print –  Prints the active parameter 
set. Select Print options, in the Print 
window/dialog box. 
 
Print Preview –  Shows how a file will 
look when you print it. 
 
Show Error Log – shows the status of 
IMPULSE•LINK 4.1 WDS. 
 

IMPULSE LINK Help – Provides information 
on communication profile settings and 
troubleshooting. 
 
Write to VFD - Saves all parameter values 
from memory to the VFD. 
 
Read from VFD - Loads all parameter values 
from the VFD to memory. 
 
Properties –  Displays the properties box to 
view the properties of the active file. 
 

Profile – Shows the selected 
profile. 
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The following gives a brief summary each of the functions that can be accessed from the navigation 
toolbar.     
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

New – Displays the controller properties dialog to create 
a new factory default parameter set, based on the drive 
type, software number, model, and kVA. 
 
Open – Opens or finds a file containing a parameter set 
for a specific drive type and software number. 
 
Save –  Saves the active file with its current file name 
and location. 
 
Save As –  Saves the active file with a different file name 
or location. 
 
Print Preview –  Shows how a file will look when you 
print it. 
 
Print –  Prints the active parameter set. Select Print 
options, in the Print window/dialog box. 
 
Properties –  Displays the properties box to view the 
properties of the active file. 
 
Exit – Closes this program after prompting you to save 
any unsaved files. 

Communication – Allows communication profiles to be 
added, removed, edited, copied, imported and exported. 
 
Preferences – IMPULSE•LINK 4.1 settings for access 
level. 
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Write Flash - Allows a binary file to be written to VFD 
flash memory. (FACTORY USE ONLY) 
 
Read from VFD - Loads all parameter values from the 
VFD to memory. 
 
Write to VFD - Saves all parameter values from 
memory to the VFD. 

Convert – Allows for parameter files to be converted 
from one software/Flash ID to another (must be 
within the same drive serie). 
 
Compare Parameters - Allows for comparison of 
sets of parameter files. 
 
Communication Test – performs a communication 
test with the VFD. 
 
Monitor – Displays a select number of monitor 
parameters (U-parameters), updated continuously. 
 
Keypad Simulator – Emulates the keypad and 
allows for navigating the keypad menu remotely (this 
is not available unless hardwired to the keypad port). 
 
Show Error Log – shows the status of 
IMPULSE•LINK 4.1. 
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Window - Allows for easy parameter window recall and 
organization. All open files are enumerated at the bottom of 
this menu for switching between files more easily. 

Users Manual – Displays the User Manual. (A .pdf 
reader, such as Adobe Acrobat Reader, must be 
installed) 
 
IMPULSE LINK Help – Provides information on 
communication profile settings and troubleshooting, 
complete Index of VFD fault codes, and a Search 
function. 
 
Magnetek Website – provides a link to the Magnetek 
Material Handling website. 
 
Check for Updates – provides a link to the download 
software page of the website that offers updates. 
 
About - Displays the version number of this Magnetek 
product, copyright and legal notices. 
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Chapter 4 -  Parameter Maintenance 
 
IMPULSE•LINK 4.1 Basic software provides flexibility in programming, uploading, downloading, and saving 
parameters. With full parameter descriptions and visual programming, modifying parameters from your 
computer has never been easier. 
 

Read From VFD 
 
This function allows you to load the parameter values from the drive’s memory.  This can be accomplished 
through the ‘VFD’ drop down menu or the ‘Read’ Icon (as shown below).     

 
 

Write to VFD 
 
This function saves all parameter values from memory to the VFD. This can be accomplished via the drop 
down on the ‘VFD’ menu or using the ‘Write’ Icon as shown here. Writing to the VFD may result in undesirable 
operation of your crane, causing danger, personal injury or death! To proceed with the write to VFD function 
you will need to accept that you acknowledge the warning message as shown here. Once you have checked 
the I Accept button, the Continue Write to VFD button will be available. 
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Parameter File Display 
 

Parameter Value Text Color 
 

Modified Constant 
A parameter with blue text implies that its value is different than its default setting.  
- This list should match the modified constants list in the drive, with the exception of A1 parameters. 
 
Read-Only 
A grayed-out, highlighted parameter implies that it cannot be modified. 
- The Access Level of the current parameter set is lower than what is needed for this specific 

parameter (i.e. Changing this parameter from the drive keypad would not be allowed with the current 
access level.) 

 
Over Maximum 
A parameter with red text implies that its value is greater than its maximum. An invalid value in 
the PAR file could result in this error. 
 
Under Minimum 
A parameter with green text implies that its value is less than its minimum. An invalid value in 
the PAR file could result in this error. 

 

Modifying Parameters 
 

1. Begin modifying a parameter by double-clicking on the row of the parameter.  
2. A drop-down list or edit box will appear in the Setting column.  
3. Press Enter to accept the change or Escape to cancel. 

 
 
Drop-down List Example. 
This is displayed for drive parameters with a finite list of options. 
 
 
 
 
 

 
Edit Box Example 
This is displayed for drive parameters with a numeric range. 
 
 

 
 

Notes: 
1. If a change is made, ENTER is not pressed to accept it, and the user clicks on another row or column, the value 

will revert back to what it was before the change. 
2. If a parameter is changed to an invalid value, under the minimum value or over the maximum value, a warning 

message will be displayed and the value being edited will revert back to what it was before the change. 
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Visual Programming  
 
An additional editing option targeted towards more complicated parameters or parameters with extended 
settings that require using a table to calculate the value. 
 

 Parameters with a Visual Programming option display an icon. 
 
To Edit: 

1. Left-click once on the Visual Programming icon 
2. Click on the appropriate selections. 
3. Choose OK to accept the change or Cancel to abort. 
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Parameter File Comparison 
 
The Parameter File Comparison function found in the Tools drop-down menu allows for comparison of two sets 
of parameter files.  Use the Load button to select the file you want to view on the left and right side.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Once the parameter files are loaded, 
you can use the  “Show” drop-down to 
compare: 

- all parameters of each file,  
- only parameters with equal 

values. 
- or only parameters with 

different values, 

Parameters shown in Red are 
parameters with different 
values. 
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Security / Password Protection  
 
The ‘Preferences’ drop-down menu in IMPULSE•LINK 
4.1 Basic software allows you to set the access level, 
username and password.  
 
By logging out of the Advanced mode, you will be in the 
User mode. While in the User mode, the drives can only 
be monitored. Write to VFD and Reset functions are NOT 
available.  

 
 
 



Page 16 of 24 

 

Chapter 5 -  Monitor Function 
 

Monitor  
 
There is a ‘Monitor’ function in the ‘Tools’ drop–down, which displays a 
select number of monitor parameters (U-parameters) that are continually 
updated. 
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Fault Reset 
 
In the event of a fault condition, you will see the fault icon on either the DataLogger window or the Monitor 
window as indicated below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
NOTE: You can reset a fault in the Monitor window as long as the drive doesn’t have a Run command and the fault 
condition no longer exists.  Once you click on the fault reset icon (as shown above), a warning message will prompt you to 
accept that you acknowledge the warning.  When resetting a drive remotely, you need to be sure that all personnel and/or 
operators are notified. Once you have checked the “I accept” box, the “Continue Fault Reset” button will be available. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fault Reset Icon 
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Chapter 6 -  Additional Menu Features 

Print Preview 
 
IMPULSE•LINK 4.1 Basic provides a compact printing mode that displays all drive parameters in only 1-2 
pages. It also prints a more detailed mode that lists descriptions as well as units for each parameter. 
 
Compact Parameter Print Preview 

 
 
 
 
 
 
 

Print 

 
 
NOTE: Only parameters that are viewable in the Parameters Window will be printed. 

Detailed Parameter Print Preview

Printer Name – Allows the user to select from any printer 
installed on his/her system. The user’s default printer is initially 
selected. 
Print Mode - Allows the user to choose the printing style.  
o Compact mode (1-2 pages) provides parameter name and 

setting value.  
o Detailed mode provides parameters, descriptions, setting, 

values and units as well as ‘modified’ information. 
o As shown prints all of the information as shown on the 

screen. 
OK Button – Prints the active parameter set to the selected 
printer in the chosen format.  
Cancel – Closes this dialog box without printing. Changes to 
Customer Name, Application and Job Number are not saved. 
 
Text placed in the Customer Name, Application and Job 
Number fields appear on the printout. 
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Parameter File Conversion   
 
‘Convert’ under the ‘Tools’ menu allows for parameter files to be converted from one software/Flash ID version 
to another (within the same drive series).  

 
 

 
 

 
 
 
 
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Digital Operator Emulator NOTES:  
 

1. To activate, select the correct drive profile from the dropdown 
and click the  button. 

2. The Keypad will automatically close if any communication 
function, such as Upload and Download, or a new offline 
parameter set is created from the Controller Properties 
window. 

3. The RUN command has been disabled for safety reasons. 
4. If the drive is put into “Program Mode” and not returned to 

“Run Mode”, the user will be unable to run the drive. 

Source – Specifies the file to be converted. 
 
Flash ID – Specifies the software type that 
the file will be converted to. 
 
Destination Filename – Specifies the 
Destination filename.  
 
Convert - Converts the parameter file 
specified in “Source” to the format specified 
in the software version in the Flash ID. The 
converted file is saved to the filename and 
path specified in “Destination Filename”. 

Keypad Emulator – The keypad emulator communicates 
with an IMPULSE drive exactly as the physical keypad does. 
This allows for remote keypad menu navigation.  
 
Note: This function is only available when IMPULSE•LINK 4.1 
WDS is connected via the drive’s keypad 1CN connector 
(instead of the standard RS485 connection) – primarily for 
training purposes.   
 
If you attempt to run the keypad simulator while connected 
via the standard RS485 connection a CF00 Comm Error will 
occur. 
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Viewing Parameters 
 
The ‘View’ drop-down box allows filtering of parameters based on parameter group organization and the 
parameter value (modified from factory defaults or from custom defaults). 
 

 
 
 

Copying to the Clipboard 
 
Impulse Link 4.1 provides the ability to copy displayed parameter information to a preferred word processor or 
spreadsheet. 
 
To do this, select one or more rows and either 
press Ctrl-C or right-click to display the 
context menu, shown to the right. The copied 
information is available to be pasted in either 
HTML format or Ascii text.  
 
 
Tip: Change from full row selection mode to single cell 
selection mode by doing the following. 

1. Click and hold the left mouse button over any 
row. 

2. Drag the mouse down while the left-mouse 
button is still being held. An icon will replace 
your mouse pointer  

3. While still holding the left mouse button, click 
the right mouse button. The icon will become 
skinnier and you will no longer be restricted to 
selecting the whole row. 

 
Repeat to return to full row mode. 
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Chapter 7 -  Troubleshooting 
 
The IMPULSE•LINK 4.1 Basic Help section 
provides the following: 
 

 Reference to Drive faults and 
corrective actions. 

 Reference to Impulse Link error codes 
and corrective actions. 

 Communication profile settings 
overview. 

 
 
 
 
 
 
 

Drive Faults References 
 
IMPULSE•LINK 4.1 Basic offers built-in Help screens for the drive faults and/or alarms.  The Help screens 
provide advanced diagnostics allowing you to troubleshoot your drive from your PC. Click the Help Icon and go 
to the Drive Fault References for a complete list of drive faults, as shown below: 
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Communication Error References 
 
The Help function provides an overview of the possible errors that could occur while running IMPULSE• LINK 
4.1 Basic, as shown here: 
 

 
 
By clicking on the type of error, you will be provided the fault code with description and correction action.  
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Communication Profile Test  
 
The Communication Profile Test Utility is a tool to 
assist in troubleshooting communication 
difficulties. It performs the following sequence: 
 

1. Opens the communication port with the 
selected settings. If the port opens 
successfully, the port exists and Impulse Link 
has access to it. 

2. Sends a loop-back test message to establish 
whether a valid device exists with the settings 
in the profile. If the loop-back fails, the device 
may not be powered, present or supported. 

3. Identifies the drive model and version. If the 
discovered type is unknown, Impulse Link does 
not support it. 

 
Note: If any of the above steps fail, an error message 
is prompted to the user with an error code (i.e. CE100). 
For further troubleshooting reference the error code in 
the help section. 

 
 
 
 

Show Error Log 
 
This function also found in the Tools drop-
down menu, brings up an additional window 
showing various status details of 
IMPULSE•LINK 4.1 Basic. 
 
 


